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Key Features

Moxa MXview network management software gives you a convenient graphical representation of your Ethernet
network, and allows you to configure, monitor, and diagnose Moxa networking devices. MXview provides an
integrated management platform that can manage Moxa networking devices, such as Ethernet switches and
wireless APs, and SNMP-enabled and ICMP-enabled devices installed on subnets. MXview includes an
integrated MIB complier that supports any third-party MIB. It also allows you to monitor third-party OIDs and
Traps. Network and Trap components that have been located by MXview can be managed via web browsers
from both local and remote sites—anytime, anywhere.

The following topics are covered in this chapter:

0 Web-based Operation
O Auto Discovery and Topology Visualization
O Event Management

O Configuration and Firmware Management
a

Traffic Monitoring



MXview Key Features

Web-based Operation

MXview uses the client-server model. You will need to install the MXview server on a Windows computer
connected to the network(s) that are to be managed. After installing MXview, the network can be managed with
Internet Explorer or Firefox, without installing additional software.

Auto Discovery and Topology Visualization

Within the scan range, MXview locates networking devices with SNMP or ICMP services enabled. MXview can
collect topology information from devices with LLDP capability and draw the topology of the network, which
shows physical connections. For ICMP devices without LLDP, MXview’s advanced auto-topology function can
verify the connection relationship through ARP algorithms, and help you create an accurate drawing of the
network topology. If any managed PoE switches are in your network, the PoE power output information will also
be visualized automatically (for more details on PoE visualization, refer to the POE Power Consumption
Visualization section in Chapter 8.)

Event Management

For troubleshooting purposes, MXview logs events that match preset conditions, such as link up/down, device
unreachable, or traffic overloading. The most recent events will show up on the dashboard. Devices and links
that generate events will be highlighted with different colors. When an event occurs, users can be notified in a
number of different ways, including SMS, email, popup window, sound, or external program.

Configuration and Firmware Management

MXview provides an interface for managing Moxa networking devices from a central location. Users can
remotely backup or update configuration files, and upgrade firmware.

Traffic Monitoring

MXview can log the network traffic of network devices that have been discovered.
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System Requirements
and Supported Devices

The following topics are covered in this chapter:

0O System Requirements

O Supported Devices



MXview System Requirements
and Supported Devices

System Requirements

The computer that MXview is installed on must satisfy the following system requirements:

Client Requirements Server Requirements

CPU Core2Duo E6550 2.33 GHz or higher Core2Duo E6550 2.33 GHz or higher

RAM 2 GB or higher 4 GB or higher

Hard Disk Space |500 GB or higher 1 TB, 7200 RPM, SATA-3Gb/s or higher

oS Windows XP, Windows 7(32/64-bit), Windows XP Professional, Windows 7(32/64-bit),
Windows Server 2008(32/64-bit) Windows Server 2008(32/64-bit)

Browser 1E6/8/9, Chrome 19, Firefox 12 or later|---

Supported Devices

e MXview supports a full range of functions, such as network status, traffic log, and configuration/firmware
file management.

e For other SNMP-enabled devices, MXview supports standard management functions, such as link up, link
down, and SNMP MIBII information.

e MXview can only monitor the connectivity of devices that support ICMP.
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Installation and Migration

The following topics are covered in this chapter:

O Installation Procedure
O Uninstallation

O Migration
a

Version Upgrade



MXview Installation and Migration

Installation Procedure

1. Execute the installation program or insert the auto-run CD.

2. During the installation, you can choose the directory in which MXview will be installed and the default
language, or leave the settings at the default values.

3. For the commercial version, you will be asked to enter a license key; the license key can be found on a label
attached to the protective sleeve of the CD-ROM.

4. After the installation is complete, shortcuts for launching the MXview server will be created on the desktop
and in the start menu.

Uninstallation

1. Select Start = Control Panel, and then select Add or Remove Programs.
2. Select MXview

3. Select Remove

You can also uninstall the software by selecting
Start = All Programs = Moxa = MXview - Uninstall MXview.

Migration

To migrate the software from one computer to another, first use Project 2 Export to save the system’s current
device list and topology to a file, and then use Project & Import to transfer the system to another computer.

Version Upgrade

To upgrade from V2.0 or above, simply run the installation file. The program will back up the current
configuration files and upgrade MXview to the new version automatically.

To upgrade from V1.1 or below, first use Project = Export to save the system's current device list and
topology to a file. Then, install the new version. Finally, use Project = Import to upgrade the system to the
new version.
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Getting Started

MXview is implemented as a web server to realize remote management through a single portal. The following

figure illustrates the operational model.

Ao -
%
[

Server f Local User

=

| r e =

Remote User

R,

-~

The MXview server runs in the background on a Windows PC and communicates with network devices using
SNMP Plus, a Moxa proprietary protocol that periodically polls specific MIB data and stores data in a local

database.

The MXview client uses web browsers to provide a uniform web interface that enables network operators to

access and operate over an intranet or the Internet.

The following topics are covered in this chapter:

O MXview Server Startup
O Login
O Account
a

Auto Installation of Runtime Environment
(Java Runtime Environment)



MXview Getting Started

MXview Server Startup

To start the MXview server, first double-click the MXview desktop shortcut. When the MXview window (shown
below) pops up, configure the listening port of the server (or leave it at the default value of 80) and examine
the runtime information. The server will launch when you click Start.

Clicking Launch Client will start the MXview client on the local computer. To learn how to use the MXview
client remotely, refer to the Login section below.

MXview
Industrial Network Management Software
Moxa Inc. All ights reserved 2012,

Service |1nﬁ;. I

HTTPS Port |443 So |

System Status:  Stop

HTTPPort |80 I™ Disable HTTP port ‘

oK I Launch Client | Stop & Quit |

Login

To launch the MXview client, open a web browser and input the MXview server’s IP address or domain name in
the address field. Note that if the server’s listening port changes, you will need to input the IP address as
follows: http://192.168.1.250:8080. If you are using the server computer as the client, you may also click
Launch Client on the control panel. The default account is admin with no password.

Industrial Network Management Software

Visualize

Industrial Ethernet Networks

e

Copyright @ 2009 hoxa Ine.

Allrights reserved. The MOXA logo and Mview logo are registerad trademarks of Moxa Inc. m
Other loge appearing in thiswebpage is the intellectual propery of the respective company or product. s

NOTE At most 3 users can log in to the system at the same time.
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MXview Getting Started

Account

There are 2 accounts: admin and guest. The admin account possesses the privileges to change configurations
in MXview, such as topology and scan range. The guest account is a read-only account. By default, the
password of both accounts is empty, which can be changed in Preferences.

Auto Installation of Runtime Environment
(Java Runtime Environment)

The MXview client must run in a JRE 6 environment. For IE users who do not have the appropriate version of
JRE, installation of the update will start automatically.

If you are using a browser other than IE, you will need to download JRE 6 from Java’s official website
(http://java.sun.com/javase/downloads/index.jsp) and then install it on your computer.
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Quick Start Using the Setup Wizard

MXview provides a Setup Wizard that can be used to quickly determine the network topology and handle basic
configuration tasks. The wizard will launch automatically when the software does not contain any nodes. To
launch the Setup Wizard manually, select Project & Wizard. You should see the following window:

W% Setup Wizard

Welcome to MXview Industrial Network Management Software Setup Wizard | '-: .

Welcome to use the setup wizard.

This wizard will help you:

1.Add scan range
2 Draw Topology (with devices having LLDF)
3 Set SMNMP trap server

| et | ’ Cancel

The wizard will guide you through five basic steps, described below.



MXview Quick Start Using the Setup Wizard

Step 1: Create Group

Devices scanned by MXview can be organized into a multi-layer tree structure. Before finding devices, groups
need to be created. Root is the only default group. All other created groups are placed under the next level of
Root.

A% Setup Wizard 3

Create Group

Lizt of Grronps

Root
Test

Create

Mext ] [ Cancel
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MXview Quick Start Using the Setup Wizard

Step 2: Configure the SNMP Community String

MXview uses SNMP to collect device information. The default SNMP configurations are:

e \Version: vl
e Read community string: public

e Write community string: private

If necessary, update this information at this time:

X

W% Setup Wizard

SNMP Settings
Select SNMP wersion and required parameters for acquiring device information

SMMF Version V1w
Read Community public
Wirite Community private

et | ’ Cancel
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MXview

Quick Start Using the Setup Wizard

Step 3: Add the networks you want to scan

MXview’s operation is based on IP (Internet Protocol). Other devices in the scan range that use IP to operate

will be located and monitored.

Scan Range

] Active FirstIP Address  LastIP Addrass
17l 1492 188,127 1 192 168,127 254

Deleted Davices

Device IP

Click Add Network to add a network range to scan. A window will pop up, with two tabs: Single Range and

Multiple Ranges.

Single Range: Enter the first and last IP address in the desired range. Name this range in the Name field.

] Active

First IP Addrass

LastIP Address

Mame

Group




MXview Quick Start Using the Setup Wizard

Multiple Ranges: The Multiple Ranges tab allows you to set up a complicated subnet for scanning. Select
enable for the subnet range, similar to using a subnet mask. You can also nhame the scan range, as in the
Single Range tab.

sww: Multiple Banges

| Active

enable @ enable

NOTE A device’s IP address must be configured properly before it can be managed by MXview.

At this point, MXview will enter the discovery stage. The time needed to complete this stage depends on the
size of the scan range. Click Cancel at this point to exit the wizard; however, the configurations entered
previously will be saved and the discovery process will continue running in the background.

% Setap Wizard (%]

Scanning
Discovering devices and topology

(LTI )

16%

Clicking the Cancel button will exit the wizard. But the discovering process will keep working in background.

Step 4: Draw the topology

After all devices have been located, MXview will be able to draw the topology for LLDP devices.
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MXview Quick Start Using the Setup Wizard

Information

\?’) Dirave topalogarivwith devices having LLIDE)

[ o [ome ]

Information

\?’) Do Yon Want to Auto Layout Topologa?

(o [ome ]

For devices without LLDP functionality, the topology can be drawn manually after the wizard is finished.
After all devices have been discovered and the topology has been created, click Next to continue to the next
step.

#% Setap Wizard 3

Scanning
Discovering devices and topology

[IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII]

100%

Complete drawing topology. Please press the Next hutton to continue!

et ] | Cancel
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MXview Quick Start Using the Setup Wizard

Step 5: Set the SNMP Trap Server to get events
in real time

To enable real-time event generation, the MXview server’s IP address needs to be configured as a trap server.
To do this, enter the IP address of the MXview Server and then click Set to activate the change.

If this step is skipped, devices can still be monitored by polling periodically, although a time latency will be
introduced.

A% Setup Wizard 3

SNMP Trap Server
Setthe SMMP trap SERVENto capture events in real time

IP Address | . . . |

Community String | |

Enter the address and the community string, or leave them empty to skip
*The process may take from a few seconds 1o a few minutes depending on the mumber of discovered devices.

*This action will overwrite the original sethngs of discovered devices

et | l Cancel

After this point, MXview initialization is complete.

W% Setnp Wizard

Welcome to MXview Industrial Network Management Software Setup Wizard | ~

Congratulations!

You have completed the basic configurations..
Now start to monitor your network!
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Dashboard Overview

The Dashboard should appear when you log in to MXview. When using MXview, you will spend most of your

time working from the Dashboard, which is divided into the following sections.

1. (Pmject View Device Link

-
WWW Inleltbsirlal ylatwons Managamani Sufiikre

Event_Tools Help )

4
Root

3 Q- 4
Dewice List

= gy Root ~
W 192168.127.5 SNMP De
~W192168.1271 PT-7628
19216812712 EDS-408 :
P 192168.127 27 EDS-408 .
W192168.127.34 EDS-40E &
192,168,127 B8 EDS-51E
~W192.168.127 104 EDS-4C
192168127105 EDE-4C
P192168127 107 EDE-4(
192168127 106 EDE-40
192,166,127.113 EDS-4C
~W182168.127111 EDS-4C pé
192168127108 EDS-40
PA192168127 10 EDS-40
£ >

4 Device Properties

[1] [
.".
19166127107
S
;

1821881270137
0 alias 19A

O ModelNane EDb
O MAC Address 0
O sysDescr o
O =ysobieceId 1
b =ysContact

0 =ysHane Ma
W syslocation S 192468427 110
CURE T mn

o <

192165027105

)

192168127 150

w

>

Recent Events Ak Al Upscked Last Fifty Events  »

5000 . F
L Ak (=]

=1 Source Source [P
-

1,7r—'—1— 5 E 3 Wiview Serv.. 0.0.0.0

2 Wiéview Serv... 0.0.0.0
<

Saverity
Systern Inf..

System Inf...
System Inf...

[

0 0 | [ anevems |

Description
“Aulo Topology' finished
“Auto Topology" stared
M server stared

Time |ssued
2011-12-2615:20..,
2011-12-2615:20...
2011-12-26 15:14...

32337 FM

J_ Defa. J__@& | O 1 Wiview Sery. 0.0.0.0
7. C

Topology has been saved successiully

Devices (Current fMax) - 32120 )

The following topics are covered in this chapter:

O Menu Bar
O Topology Map

O Device List

O Device Properties List
a

Recent Events List



MXview Dashboard Overview

Menu Bar

All operations can be accessed from the following menu bar items:

Project

Use the Project menu to back up data and configurations of the monitored networks, event history, job
schedules, or network topology to a local file, or import a project file to create monitored networks on the fly.

View

Use the View menu to change the appearance of the Topology Map. For example, you can adjust the resolution
or create a topology map.

Device

Use the Device menu to configure or examine the properties of objects.
Link

Use the Link menu to delete a link or get traffic reports.

Information

Use the Information menu to examine network-wide properties.

Event

Use the Event menu to examine events.

Tools

Use the Tools menu to launch additional services or programs, such as Moxa IP Configurator.

MIB

Use the MIB menu to compile or browse for a third party MIB. Import third party OIDs and Traps through the
OID import manager and the Trap import manager.

Help

Use the Help menu to view license information or information about MXview.
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MXview

Dashboard Overview

Topology Map

The Topology Map displays connection relationships of monitored devices. For devices with LLDP capability,

the connections can be drawn automatically.

Root

[it]

J
1%2’.'1 68.127.107

£ pf
K4 3
B
.’b
."
- ;‘

192168127 109

N e P =

pr

]

p8

192.188.12?.11&7

i

192188127110

pé92.1 B3127.

il
e
192188127 130

Device List

The Device List shows the Topology Map structure in tree format. Note that link information is not shown.

Type all or part of a device name in the “Search Devices” input box to only show devices whose names contain
that keyword (for example, type “"EDS” to show all EDS devices, or type “"EDS-G509” to show all EDS-G509

switches in the network.

Device List

=% Root

#192168.127.5 SNMP Device
-~ W92 1681271 PT-7828
=192 16812712 EDS-408A
~TW192 16812727 EDS-408A
~TW192.168.127.34 EDS-408A
~W192.168.127.28 EDS-518A
~TW192 168127104 EDES-4084A
~W192 168127105 EDS-4084A
~TW192 168127107 EDS-4084A
~TW192 168127 106 EDES-4084A
~W192 1681271132 EDES-4084A
~W192168.127 111 EDS-4084A
- B192168.127108 EDS-4084A
W92 168127110 EDES-4084A
192168127112 EDS-408A
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MXview

Dashboard Overview

Device Properties List

The Device Properties list shows the properties of the device that is currently selected. If a device's interface
is a PoE port, the icon will change to include a yellow electric charge.

@) sysDesce

) sys0bjeceld

@) sysConcacc

W syaslane

@) zvyslocacion

U ifHumber
B8 incerface. 1
B-%l interface.
B8 incerface. 3
%8 interface.
FH = interface.

|

[

L

Device Properties
O Alias 192.168.129.2 EDS-PSO06A ﬂ
O ModelNane EDS-PS06A
) HAC Address 00S0ES040404
O Availabilicy 100.00%

HOXA ED3-P506A-4F0E
1.3.6.1.4.1.869]1.7.41

Hanaged Redundant Switch 00000
Switch Location

]

dowmy /S LOOH / Full-duplex

up F 10H / Full-duplex

downy /S LON / Full-duplex

up / AWNE-3121 / 10M / Full-du
up J L0M ;f Full-duplex ﬂ

| =]

Recent Events List

This list shows the events that have occurred most recently.

Event Count lists the total

number of events of different types, with different event types identified by

different colored rectangles (e.g., red, yellow, and green, as shown in the following screen shot).

All Events is the shortcut of the menu item Event & All. When you click All Events, a window will pop up

showing all events.

Recent Events ’ Ack All ] |Unacked Last Fifty Events 3 | 2 | | 31 | ’ All Events ]
Ack |n] 1 Source Source IP Severity Description Time Issued
[d] 40 Miview Server 192 168.127182 Information Device ICMP reachable 2011-12-26 152616 »
[d] 34 Mxview Server 192 168,127 236 Information  Device ICMP reachable 2011-12-26 15:26:16
[d] 38 Miview Server 192 168.127.254 Information  Device ICMP reachable 2011-12-26 15:26:16
[d] a7 Miview Server 192 168.127.252 Warning Device SMMP unreachahle 2011-12-26 152616
[d] 36 Mxview Server 192 168.127.253 Critical Device [CMP unreachahle 2011-12-26 15:26:15
[d] 35 Mxview Server 192168127 250 Critical Device [CMP unreachahle 2011-12-26 15:26:15
| ] a4 A i Cropenr AN AR0 A7 228 Triti 1 m i LhAD o k kil 044 AT IR AEEAE v
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Device Discovery and Polling

Devices in the assigned scan range can be discovered via SNMP and ICMP protocols. After a device is
discovered, MXview will use SNMP and ICMP to poll the device periodically. To configure this function properly,
you will need to know the following information:

1. The IP addresses of the devices on the network.

2. The Read community name assigned to the devices on the network.

Change Read Community String

The default Read community string that is used to discover devices is public. Take the following steps to
change the value:

1. Select Project ©> Preferences - SNMP Configuration.

2. Enter the new Read community string.

#% Preferences

F'rEfEFEUCES SMMP Configuration
Easic

2 User
Display
¥ Appearance
Advanced r
® System Configuration Read Community public
8 F5MMP Configuration .
® Events Wtite Community 'private

SNMP Version vl v

Ok ] [ Cancel
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Device Discovery and Polling

Scan Range

You can assign multiple scan networks, with each network defined by a starting IP address and an ending IP
address. MXview will discover all active devices that belong to the scan networks.

Take the following steps to add a scan network:

1. Select Project & Scan Range.

#% Network Scan Range

Scan Range

Add Metwork
[] Active First IP Address LastIP Address MName
192.168.127.1 192.168.127.50 A Modify Metwark
Delete Netwark
Celeted Devices
Device IP Model Laocation

x)

QK and Run Discovery ] Cancel

2. Click Add Network.

#% Add Network

FirstIP Address
LastIF Address

MName

Group Root

[ ok

] [ Cancel ]

3.
4. Click OK & Discovery to start discovery.

Input the starting and ending IP addresses of the range, and then click OK.

NOTE

Device discovery will require more time for larger networks. For this reason, if possible you should avoid

defining large scan ranges.
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Deleting a scan network will remove the monitored devices that belong to the network. Take the following steps

to delete a scan network:

1
2
3.
4

Select Project & Scan Range

Select a row in the table Scan Range
Click Delete Network

Click OK to activate the change

Modifying a scan network will remove devices that do not belong to the new network, and discover new devices

within the new network. Take the following steps to modify a scan network:

u kAL

Select Project > Scan Range

Select a row in the table Scan Range

Click Modify Network

Modify the starting and ending IP address of the range, and then click OK
Click OK to activate the change.

Deselecting the Active checkbox of a scanned network will stop device discovery for that network. Previously

discovered devices will continue to be monitored, with the current status shown on the topology map.

Device Discovery

MXview will use SNMP and ICMP to discover devices within the scan ranges. When a Moxa device has been

located, MXview will use an actual image of the device, such as the one shown below, to indicate the device’s

location in the network.

MXview will also list detailed properties and configuration parameters, including the following:

MAC address

Model name

IP address

Netmask

Gateway

Trap server address

Auto IP configuration

Type of redundancy protocol
Role in redundancy protocol
Status and properties of the port
Status of the power

Status and version of the SNMP protocol
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MXview will use one of the following graphics to indicate devices:

BADMA

e Moxa devices with SNMP enabled.

e Third party devices with SNMP enabled. l m:
e Third party devices with ICMP enabled. l w

The IP address and location name of the discovered device will be shown under the image of the device. Take
the following steps to change the location name:

1. Select the device
2. Select Device~> Maintenance-> Configure IP & SNMP

3. Select the Basic tab and then enter the new location name.

MXview will run conduct device discovery periodically to find new devices in the scan ranges. You may also use
the following steps to conduct device discovery manually:

1. Select project & Scan Range
2. Click OK & Run Discovery

Discovered devices will be polled periodically by ICMP and SNMP. This is done for the following reasons:

1. To monitor the availability of devices.
2. To update properties and configuration parameters of devices.

3. To update traffic information, such as utilization.
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Topology Management

The Topology Map is the core of MXview, and can be used to complete most actions. The Topology Map shows
a graphical representation of the devices in your networks, and can be used to do the following:

e Display a graphical representation of a real network.

e Show connecting relationships between devices.

e Indicate the status of devices and links.

Multi-layer Tree Structure

The Topology Map can be organized into a multi-layer tree structure of up to 5 layers. It helps users manage
a large number of nodes on the computer screen. For example, users can move nodes of the same subnet or
location into the same group. Root, which is the only one group at the first layer, exists by default and cannot
be deleted. Groups created by users are in the layer under Root. Devices can be moved between groups.
MXview uses an icon to indicate user-defined groups:

The first layer will be shown as:

Root | subnet = [\ [" ['l I"I-I-. [' 0 'E::-

subnet G
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Topology Management

The second layer will be shown as:

Root| subnet
192168127 162
192.1658.127 162 EDS-4084,
Foat
p2
Ring 1 Mast
l G
193485127 235
192.168.127 67 -\
4] p2
N
N
\
pY
p2 '\p1
\-
\,
p1
p2
192168127 236 192.168.127.237

S 0 B 5

The map is represented as a tabbed window, in which each tab is a group. Double clicking a group icon in Root

will open the corresponding tab.

Auto Topology and Auto Layout

For devices with LLDP functionality, MXview can draw the physical topology map, down to the port level of the

devices. For devices without LLDP, MXview is able to draw links by using ARP.
the Advanced Topology Analysis checkbox.

To activate this function, select

MXview can do the following two tasks automatically: (1) Create a new topology, and (2) Update the existing

topology.

Creating a new topology deletes all links, requests LLDP information from devices, and draws topology maps

based on the gathered information.

1.
2.

Select View = Auto Topology
Select New Topology
Click OK

i '

Existing links will be deleted first

(") Update Topology

Existing links will be kept while new links are added

Advanced Topaology Analysis

*Additional time is required.

oK l [ Cancel
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NOTE

Links drawn manually will be also deleted by this action.

NOTE

Your devices must have firmware version 3.1 or higher to use Advanced Topology Analysis.

NOTE

If the AutoTopology function oes not create an accurate representation of the actual network, deselect the
Advanced Topology Analysis check box and try again.

Updating the existing topology adds new links and updates existing links, but does not change the status of
links that are indicated as having been disconnected or links that were drawn manually.

1. Select View = Auto Topology
2. Select Update Topology
3. Click OK

'd ™
2 o oror, I =

Mew Topology

Existing links will be deleted first

@ Update Topology

Existing links will be kept while new links are added

[¥] Advanced Topology Analysis
*Additional time is required.

oK H Cancel

The following figure shows an example of a topology map:

-

1921468127 34

02182 127 5
pE

bl
g 1 hlaster

)

AD2 168127 116
o PE

\‘95

b

)

AB2AZT 05

102,152,127 105 192 AG2 1427 114
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Auto topology supports third-party devices which are compatible with LLDP MIB.

Moxa Device* Third-party SNMP IP Device
Device
Auto Topology LLDP MIB LLDP MIB Supported if connected to
ARP-based auto topology a Moxa switch.

(Moxa switch w/firmware
3.1)

Redundant Topologies

Redundant topologies have at least one backup link, which will be indicated with a dashed line:

pE =5
S

1%{3'158.12?.10? 182 68 127,
‘f"p? pe
"'
== T
‘a
“'
K
02 AGSH2T .00 192 AEE [ ZF 105
=X pe
pE =Ny
hlafter
1921 E.'12T.11'§? pé92.1m.1 27104
=3 =N}

192162127 110

For devices that play a particular role in the topology, MXview will label the devices by displaying the roles
above the images of the devices. Backup links will be indicated with dotted lines.

e RSTP has a Root

e Turbo Ring has a Master

e Turbo Chain has a Head and a Tail

NOTE Only auto topology can draw dashed lines for redundancy links. Manually drawn redundant links will appear as
solid lines.
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PoE Power Consumption Visualization

By periodic polling, a PoE link will display the port number, power (watts) voltage (V) and current (mA) directly
on the topology map.

-

H!ng 1 Master| p6 ="
‘ ‘ 192.168.129.2 port 4 di

# ph AW T 54 1 T5mA ‘
192, 1551252N

192.168.129.3

Third-Party Icons

MXview is able to support most network devices, even those made by many different vendors. Below is an
example of anetwork which includes Moxa devices and a Cisco device. MXview will change the device icon to
indicate that the device is a Cisco device.

A0 DT I e
r

+ S | D 1 168127, 581 v b oA
Frowt vew Dewis Lk iimason B Tous Wil Hew

-
Ww [nketidriul o sk atuns alsaiigaununt Sultauoe MDKA

oo e - BT

1 et

=
& | owem | & |Fw .
Tasvitgy firk baes e W con by TH I Mhirabguied Copsbt i (T urvendl | i) | 71 3000
o] RGO V1M i MMIDETEMImy v 3] ORBCIECOLITMEmy o] CERCGE ey 5] ENMPIOE . 5 RIENTE. x

Vendors with MXview support includes: ABB, CISCO, Emerson, Hirschmann, Rockwell, Schneider, and
Siemens.

FelEEEEE
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Port Trunking

Port trunking, also called link aggregation, involves grouping links into a link aggregation group. Trunking links
will be indicated with thick, solid lines.

N e 2 T s

wanF

192168127 .2 192168127 1

NOTE Only auto topology can draw thick lines for trunking links. Manually drawn trunking links will appear as solid
lines.

NOTE For trunked link, check “Device Properties” to get the port number corresponding to the trunking group.

----- w Port 29 Toond Geowp 1 Port 25 (Link up) f Port 26 (Link up)

Adding a Link

Use one of the following two options to connect two devices with a link in a topology map:

1. Right click on a device and then select Add Link.
2. Click on a device to select it and then click Link = Add Link on the menu bar.

3. Enter the ports and IP addresses corresponding to the link. Use the plus sign at the left bottom corner to add
multiple entries at one time.

®eE Add Link 192 168.127.105 @

sonrce TP From Port Destination [P Diestination Port
192 . 168 . 127 . 105 o .o .0 .0
+ DK ] [ Cancel

NOTE Trunking and redundancy links added manually will appear as solid lines.

NOTE Port numbers must be numeric and entered correctly to obtain the correct traffic information.

NOTE For modular switches, a port number depends on the chassis to which the port belongs, but not on how many
modules are inserted. For switches such as the PT-7828, the first module’s port numbers are from 1 to 8, the
second module’s port numbers are from 9 to 16, and so on. The port humber depends only on which slot the
module is in; in other words, the port number is the same regardless of whether other slots are empty or
occupied.

Delete a Link

Use the following steps to remove a link in the topology map:

8-6



MXview Topology Management

1. Select the link.
2. Right-click the link and select Delete Link, or select Link > Delete Link.

ol

Link Traffic J

102 168.127.44 | Delete Link |
Critial Threshold

NOTE Deleting a link will delete a link from the topology map, but it will not affect the actual network configuration.

Delete a Device

You can delete devices from the topology map. After a device is deleted, it will be removed from the topology
map and scan range, and the device would not be polled or located when conduction device discovery. Take the
following steps to delete a device:

1. Select the device

2. Right-click the device

3. Select Delete Device

Deleted devices will be recorded in Project > Scan Range.

#% Wetwork Scan Range g|
Scan Range
Add Metwork
[] Active FirstIP Address LastIP Address MName
192.168.127.1 192.168.127.250 CBD Modify Metwark

Delete Metwork

Deleted Devices
Recover

Device IP hodel Location
192.168.127.100 Deleted Device 1839

[ QK and Run Discovery ] Cancel

You may recover devices that have been deleted. Once recovered, the devices will be polled and located when
conducting device discovery Take the following steps to recover deleted devices:

1. Select Project > Scan Range
2. Select a row in table Deleted Devices
3. Click Recover and then click OK
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Navigation

Mini map is a frame with a slider for adjusting the resolution. This function helps users zoom in to enlarge
devices or zoom out to view more devices on the screen.

e J o & I

Background

You may insert a background image into the topology map to provide additional references, such as
geographical information or deployment layout.

Take the following steps to insert or change a background image:

1. Select View = Background = Set

2. Choose an image from the local file system.

Take the following steps to delete the background image from the topology map:

Select View = Background - Delete

FProject  Wiew Dewvice Link MNetwork Event Tools Preferences Help

WVi@W Jpleltisirkel Maiwans Mareigzmant Sujiveire M OXA
I:: W Devices i @ Mavigation ]

Device list

0 All Events

Recent Event Event Count [l 0 i
D 1 Source Severity Description I5sued Time User
Configuring Discovery Range Failed 4 09:35:01 Mumber of Managed Devices § Wax . 0/ 500

Export Topology

The topology map can be exported as a JPEG image. Take the following steps to export the topology map:

1. Select View = Export Topology
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2. Choose the location to which the image is saved.

OPC Tag Generation

MXview can generate OPC 2.0 compliant tags for device and link properties. Then, OPC clients such as SCADA
systems can access and use these tags.

1. Select Tools = OPC Server
2. Click Start.

Currently, information that MXview can prepare as tags include: a device's IP address, MAC address,
description, location and status, which are labeled beginning with D_, and a link's corresponding IP addresses
and ports, which are labeled beginning with L_.
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Event and Notification

Monitoring Methods

Monitoring can be conducted using SNMP trap messages, periodic SNMP polling, periodic ICMP polling, or color
coding, as described in the following subsections.

Monitoring via SNMP Trap Messages

By using the MXview server as a trap destination of a device, events associated with the device will be sent to

the server in real time, and can be seen by remote clients.
Take the following steps to set the trap destination of all devices:

1. Select Network > Set SNMP to All.
2. Enter the IP address of the MXview server and the community string.

W% Set Trap to Al §|
Sener Mumber 1 »
IP Address 192 . 168 . 127 . 100

Community String public




MXview Event and Notification

Take the following steps to set the trap destination of one device:

1. Select Device®> Maintenance-> Configure IP & Trap
2. Choose tab Trap Server

3. Enter the IP address of the MXview server and community string

#1902 168127132 Config IF and Trap

Baszic TIF‘ Cnnﬂguraticy/r Trap Berver

Diestination [P1

Community Mame

Destination P2

Community Bame2

[ox ] (oo ]

The event types include port link up/down, power on/off, topology change, and configuration change.

Each discovered device will be monitored automatically by trap once its trap destination is configured correctly.

Monitoring via Periodic Polling

After a device has been discovered, MXview polls the status of the device’s active port periodically. Keep in
mind that since trap messages are transmitted by UDP protocol, there is no absolute guarantee that the
messages will be received. What periodic polling does is provide a higher level of reliability for monitoring
devices.

With periodic polling, MXview can passively monitor the device’s SNMP service, bandwidth utilization, error
packet rate, and collision rate. MXview can also actively monitor device availability through ICMP polling.
MXview pings devices every 10 seconds, and calculates average availability in 24 hours.

Separate thresholds can be used for bandwidth utilization, error packet rate, and collision rate. Separate
thresholds can be used for bandwidth utilization, error packet rate, collision rate, and device availability,
respectively. When any of these thresholds are surpassed, the device will indicate that an event has occurred.
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Color Coding Indicates Problems

When a link causes a warning to be issued or a critical event occurs (link down, for example), the color of the
corresponding link line will change:

19216812736

192168.127.34

When a device causes a warning or a critical event occurs (device failure, for example), the errant device will
be indicated with a box with red borders.

/

-
=

In addition, the events will be added to the recent events list.

i

L Bowmee Beverity Deseription Issued Time Oser
225 192168127 36 Critical Fart1 Link Down 2009-11-24 21:36:51
226 192.168.127.34 Critical

Port 2 Link Down 2008-11-24 21:36:52

Event Recovery

Events will be recovered automatically when condition that caused the event is resolved.

1 Source Severity Description Tssued Time User
225 102168.127.26 Critical Port1 Link Down 2009-11-24 21:36:51
226 192.168.127.34 Critical FPort 2 Link Down 2009-11-24 21:36:52
227 192.168.127.36 Information

Fort1 Link Down Recovery  2008-11-24 21:38:14
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Severity Level

Events can be set to one of three severity levels: critical, warning, or information. The conditions that give rise
to a particular severity level can be configured by the user. To configure the severity levels, select Project -

Preferences 2 Events, and then modify the settings.

| Basic Severity Threshold
5‘; Usar

] D-;plar
g Topalogy o
g Appearance Link Down

H Dienice Appearance
o | Bandwidth Litilization Over (%) 1}

J Advanced
iy Fre = =
] ':;'} Systern Configuration || Bandwidth Utilization LUndar (%) i}
o’
' :‘,,} Daics 7] Packst Error Rt Over (%) 0
t

i
1,3 SNUP Configuration

i}@ 1] Awailability Under(%) 95.00

Information

Crincai

Waming
L)
=

.Wa'nng

Clase

Recent Events

MXview shows recent events at the bottom of the Dashboard.
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Event History

To show the event history of all devices, select Event = All from the menu bar.

To show the event history of a single device, click the device to select it, and then select Event = Device from
the menu bar.

#% All Events @

Filter Conditions

Source Any v | Atk | Any ~ | From w | (00 w100 v To | (23 w158 v
Ack D Source Source IP Severity Description Tirme lssued

O 19 Iview Server 192168127106 Critical Device ICMP unreachahle 2011-12-26 16:26:11 ~

[ 20 hfview Server 192168127113 Critical Device ICMP unreachahle 2011-12-2616:26:11

O 21 hfview Server 192168127111 Critical Device ICMP unreachahle 2011-12-2616:26:11

O 22 hfview Server 192168127108 Critical Device ICMP unreachahle 2011-12-2616:26:11

O 23 Mview Server 192168127110 Critical Device ICMP unreachahle 2011-12-2615:26:11

O 24 hview Server  192168.127.236  Warning Device SMMP unreachahle 2011-12-2615:26:13

[d] a5 Wxview Server 1892168127112 Critical Cievice I[CMP unreachable 2011-12-26 156:26:13

] 26 Wixview Server 182168127150 Critical Cievice I[CMP unreachable 2011-12-26 156:26:13

] ar Wiview Server 182 168127 67 Critical Cievice ICMP unreachable 2011-12-26 16:26:13

] 28 Mixview Server 182 168127 .91 Critical Cievice ICMP unreachable 2011-12-26 16:26:13

] 29 Miview Server 182 168127 162 Critical Device ICMP unreachable 2011-12-26 15:26:13

] 30 Miview Server 182 168127 200 Critical Device ICMP unreachable 2011-12-26 15:26:13

| 31 Miview Server 182 168127103 Critical Device ICMP unreachable 2011-12-26 15:26:15

| 32 Miview Server 192168127102 Critical Device ICMP unreachable 2011-12-2618:26:15

| 33 Miview Server 192168127 237 Critical Device ICMP unreachable 2011-12-2618:26:15

] 34 Miview Server 192 168.127.235 Critical Device ICMP unreachable 2011-12-26 15:26:15

] 35 Myview Server 192168127250 Critical Device ICMP unreachable 2011-12-26 15:26:15

] 36 Miview Server 192168127253 Critical Device ICMP unreachable 2011-12-26 15:26:15

] ar Myview Server  192168.127.252  Warning Device SMMP unreachable 2011-12-26 15:26:16

] 28 Myview Server 192168127254 Information Device ICMP reachahle 2011-12-26 15:26:16

I 349 Myview Server 192168127236 Information Device ICMP reachahle 2011-12-26 15:26:18

I 40 Myview Server 192168127182 Information Device ICMP reachahle 2011-12-26 15:26:18

O 41 Miview Server 192168127183 Information Device ICMP reachatble 2011-12-26 15:26:16

O 42 Ixview Server 192168127181 Information Device ICMP reachatble 2011-12-26 15:26:16

O 43 Mview Server  192.168.127.252 Information Device ICMP reachatble 2011-12-26 15:26:16

O 44 Mview Server 1921681271 Information Device ICMP reachatble 2011-12-26 15:26:17

[ 45 hview Server 18216812712 Information Device ICMP reachatble 2011-12-2615:26:17 o
[ First Page ] [ Previous Page ] [ Mext Page ] [ Last Page ] 1M1 [ Export fo C5Y ] [ Clear Al ] [ Close ]

The table contains 40 entries on a page. Use the page controls at the bottom to navigate between pages.

First Page ” Previous Page ” hext Page ” Lazt Page 1/1

You can sort the table by clicking the header cells.
Time 1zsued L
To filter the table, use the selection box of the header cell and select a value.

Filter Conditions

Source Ay hd Ack | Any hd From | (00 »|:|00 % To | (23 ¥|[:[59

NOTE

The sorting and filtering functions only affect table entries currently showing on the screen. They do not
regenerate the entire table. This remains true even if there are currently fewer than 40 entries showing.

You can export all events to a CSV file, or delete all events from the database.

Export to CSY ” Clear &1
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Notification

You can associate an action, such as send a text message, send an email, make a sound, or run an external
program, with a combination of a type of event, a source IP address, and a severity level.

Add an SMS Action

To send an SMS notification, first connect an SMS modem, such as the Moxa Oncell, to an MXview Server COM
port. Take the following steps to configure SMS notification:

1. Select Event = Notification
#% Notification

Action List

MName Type Caontact! Pragram § File

Modify

=
S

Delete

MNotification List

Mame Type Source Companent Severity Actions e

Madify

dlcld

Delete

Email Server i SMS COM Part 0]

I
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2. Click Email Server / SMS COM Port

%% Email Server Setup E

- Email Setver Setup

Domain Mamef 1P ]

Liser Mame ]

Fassword |

Sender Address |

~S8MS COM Paort Setup-

COM Fort |com
Eaud Rate |115200 =]
Made TEXT Mode -]

0].8 ‘ Cancel l

3. Select the COM port to which the modem is connected and then click OK.
4. Click New in the Action List
5. Select SMS as the type, type the phone number, give the action a name, and then click OK.

W A cHons

Marme Admin SMS

Type Sh5 v

Fhone Mumber 09201234456

[ox ] (o]

6. Click New in the Notification List.
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7. Select the action just added and the corresponding event type, source IP.

8.

®® Notification

Motification
Motification Mame | |
Event Type |ICMP Unreachable v |
Source | _ |
Action
I Ok ] ’ Cancel ]
Click OK.

Add an Email Action

Take the following steps to configure the Email (SMTP) server to send an Email notification:

1.
2.

Select Event = Notification
Click Email Server / SMS COM Port

Input the SMTP server that can send an e-mail and the user name and password needed to log in to the
server, and then click OK.

Click New in the Action List.

Select Email as the type, type the email address, give the action a name, and then click OK.

®E A cHons

Marme

Type

Ehdail

Admin Email

Email w

|admin@‘yuur.cnm |

ok ] [omea |
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6. Click New in the Notification List.
7. Select the action just added and the corresponding event type, source IP.
8. Click OK.

Add a Sound

When a sound notification is triggered, the MXview server will play the associated sound file. The sound will
play repeatedly until some stops it manually. Take the following steps to add a sound:

1. Select Event = Notification
2. Click New in Action List.

3. Select Sound as the type, select a file from the local computer, give the action a name, and then click OK.
The file will be uploaded to the MXview server.

= A chions E|

Marme Admin Sound

Type Sound w
Sound heepway
[ (] ] [ Cancel ]

4. Click New in the Notification List.
5. Select the action just added and the corresponding event type, source IP.
6. Click OK.

When a associated event occurs, the sound file will be played and a window will pop up:

! ‘_m Stop playing the sound

| OK | | Concel |

The sound will not stop until someone clicks OK.

NOTE When more than one event occurs, the sound file corresponding to the first event will be played first, and the
sounds corresponding to subsequent events will be queued. After first sound is stopped, the next sound in the
queue will be played.

NOTE Only the wav format is supported.
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Add an External Program

When a program notification is triggered, the MXview server will execute the associated program. Take the
following steps to add a program:

1. Select Event > Notification.

2. Click New in the Action List.

Select Program as the type, select a file from the local computer, give the action a name, and then click OK.
The file will be uploaded to the MXview server.

4. Click New in the Notification List.
Select the action just added, the corresponding event type, and the source IP.

6. Click OK.

When an associated event occurs, the program file will be executed.

Network Event Playback

Whenever MXview detects that a device under its management is experiencing an event, such as link down,
MXview will update the device status in the topology map. Moreover, MXview will keep records of status
changes in a database for up to 30 days, and provides an interface that allows users to go back and check
network status from any time within 30 days in a visualized way.

Enable Playback Mode

The playback mode is disabled by default. To enable it:

1. Select Project »> Preferences

2. Click System Configuration, choose Enable for Playback

X

#% Preferences

\i) Basic Systern Configuration
2% user
@ Display
N Background Discovery Disable v
""" Bl Topoiogy
Threshold of Disk Space 0 WME {Alarmis disabled if setto 0}

""" g Appearance
""" g Device Panel

@ Advanced

el Flayback Enahle v

*When "Playhack" function is enahlg d status of devices and links while an e
vent happened, and you can enter pllSELE o watch detail pracess.
*Additional disk space is required when "Playback function is enabled.

0K | [ Close




MXview Event and Notification

Enter Playback Mode

To enter the playback mode, choose Playback as operation mode at the index page.

Industrial Network Management Software

Username

Password

vistialize -y I

Operation Mode

Monitor b
Monitor '

Playback

Industrial Ethernet Networks

Time Mode and Event Mode

There are two event playback modes. In time mode, MXview will replay the event on the topology map on a
second-to-second basis. In event mode, MXview will replay event by event. Users can select playback speeds
from 1X to 16X.

Overview of Playback User Interface

MNXView industrial Network Managemert MOXA
Event Playback

SRoot
=
= BT
s
1?2158.127.10? Ri=rRl= N =rR |
.“‘
ps",‘w pENeT
s =
192.168[127.105 W
P
B
i,
2 [24]
182168127 150
L
192,168 127,
(]
P
192188127 110 Z
v
-
2011-12-26 153423 !
00:00 02:00 04:00 06:00 08:00 10:00 12:00 14:00 16:00 18:00 20:00 22:00 24:00 @ . Device SNMP reachable
69 Mi.. 1921 @ ... Device SMNMP reachable  2011-1...
1% - A 68 M. 1921, @ ... Device ICMP reachable  2011-1...
1~ 1:1 ) |67 Wb 1921 @ . Device ICMP reachable  2011-1..
vent Mode - = 66 Mivi.. 1921 @ ... Device ICMF reachaple  2011-1..
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e Topology map
The topology map displays the network status at the time indicated in the time indicator.

o Event List and All Event button
The events surrounding the current displayed event are displayed in this window. The most recent event is
highlighted. Click All Events to access an all events search box, with filters. In the filtered results, you can
click on a filtered event to jump straight to that event in the playback.

¢ Control pane
The control pane includes a time indicator, time slider, and calendar, which correspond to the network
currently displayed on the topology map.

Users can slide to the time point they would like to check. The slider covers 24 hours in the selected date. To
change the date, users can click on the calendar and choose a different date.

9-12
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Traffic Reporting

MXview compiles traffic statistics for devices running on the network. The statistics are used to create reports
that show trend utilization and performance of the device interfaces. Statistics are complied for the following
items:

e Traffic utilization (%)

e Error packet rate (%)

Events will be generated when one of these items is above or below the corresponding thresholds.

Checking the Trend

Before MXview can collect traffic statistics between two devices, a link must be created (see the section “"Adding
a Link” in chapter 8 to see how to add a link).

Right-click on a link, then choose Link Traffic, and choose either Port Traffic or Packet Error Rate
monitoring mode.

Link Traffic 4 Part Traffic

Delete Link Packet Error Rate
Severity Threshold

In Port Traffic mode, the graph shows the utilization percentage by a specific time period. You can define your
time period at the window’s top right corner. The minimum interval is one day.

#% Link Utilization x|
Utilization 2012-06-05 To 2012-06-06 ~ 6oz <]
From 192.168.127.12 Port7? To 192.168.12737 Portl
From 192.168.12727 Portl To 19216812712 Port7 @ From [fa52002 ¢ 1o [EYEE -]
0.0100
#
So0.007s
"
o
5
| ]| JANREE] |
0.0050
| . i
| | | |' ‘"‘I_
0.0025
06-Jun 00:00 0&-Jun 12:00

Default Size Export Graph | Export Data oK
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The Y-axis scale (percentage) is adjustable, and is accurate to 4 decimal points. To change the Y-axis scale, you
just need to roll your mouse wheel down or up. No matter what scale you change it to, you can press the
Default Size to restore graph scale back to the original setting.

The data shown here can be exported. At the bottom of the window, you can export the graph as a PNG file or
export the data as a CSV file.

The interface for Packet Error Rate and Port traffic monitoring is identical.

Threshold & Event Notification

The traffic conditions below can trigger events:

1. Bandwidth utilization is over a threshold.
2. Bandwidth utilization is under a threshold.

3. Packet error rate is over a threshold.

Since a link is bidirectional, the event will be triggered when one of the directions satisfies any event'’s trigger
condition.

To learn how to change the threshold, refer to Monitoring Methods 2 Color Coding Indicates Problems >
Severity Level in Chapter 9.

To learn how to configure notification, refer to Monitoring Methods 2 Color Coding Indicates Problems >
Notification in Chapter 9.

10-2
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Device Management

Device Properties

MXview provides three ways to view device properties.

1.

Device Property box in main window
(see the Device Property List section in chapter 4)

Fast Device Property

Right click on a device in the main screen and click property.

You may select a device and right click on it. Properties that are listed include model name, MAC address,
IP address, Netmask, gateway, port type and status, power status, redundancy protocol, SNMP, and ICMP
availability.

Customizable Device Property

In the menu bar, select Information>Device Property

Device property provides a highly customizable table to view the device properties in your network. On
the top of the window, editable optional items include IP, Alias, Property and Value.

By selecting the drop-down menu on each option item, you can filter specific items which you wish to
display.

The property item has the same property as an inventory report (Refer to the section Inventory Report
in Chapter 11). As a result, you can use device property to filter out the specific property you want to see.

i ~ | Aliss ~ | Property - | Value -
19216812712 Matt's Switch #2 poweer! InputStatus an
19216812727 Matt's Switch #1 power! inputStatus on
192 168127 B1 192 168127 61 EDS-4 . power! Inputstatus on
182168.127 62 192.168.127.62 EDS-4 .. power! InputStatus on
192168127155 192.168.127.155 EDS-... powerl InputStatus on
192168127156 192.168.127.156 EDE-... power! InputStatus on
192168127250 192.168.127 2450 EDS- . power! InputStatus off
192168127251 192.168.127.251 EDS-.. powerl InputStatus off
1921681292 192.168.129.2 EDS-P4... power!InputStatus on
1921681204 192.168.129.4 EDE-GA_. power! InputStatus off
1921681295 192.168.129.5 EDS-GA... powerl InputStatus aoff
19216812098 192.168.129.8 EDE-40... powerl InputStatus off
Export ta CSW ‘ Close ‘

The Device Property window is able to export to a CSV file. To do this, simply click the Export to CSV button.

Device Virtual Panel

MXview can show the front panel of Moxa switches, and indicate the active status of ports and LED indicators:

Right click on a device and select Panel
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Changing Device Properties

Take the following steps to change a device’s location, name, contact, IP, netmask, gateway, trap server, and
SNMP configuration:

1. Select a device.

2. Select Device > Maintenance > Configure IP & Trap.

Click the Basic tab to change the name, location, and contact information for a device. The new values will be
written to the device’s firmware.

Click the IP Configuration tab to change a device’s IP address, netmask, gateway, DNS server, and method
of obtaining the IP.

Click the Trap Server tab to change IP addresses and community strings of trap servers. Moxa switches can
send trap messages to at most 2 trap servers.

Click the SNMP Configuration tab to choose the SNMP version and enter the corresponding parameters.
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w102 168127132 Config IF and Trap

E:as/iJ IF Configuration ]’Trap Server

IP Address | . 168 127 122
MNetmask | 255 . 255 255 0
Gateway | 0.0 0 0
DN&1 IP | 0 . 0 0 0
DNS2 1P | 0. 0 0 0
Ao TP Disabled v |
I 0] ] [ Cancel ]

Assign Icon

MXview allows users to change the device icon manually. Follow the steps below to select a device icon from

within MXview’s icon database.

1. Select a device.

2. Select Device >Maintenance > Assign model.

You will see the Assign Model window pop up. Select a switch model from the drop-down list, and click the

Assign button to confirm your selection.

192.168.127 4

EDE-4084

Assign to model

=

Web Console Login

To log in to the device’s web console, select Device - console.
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Note: For IE6, MXview will open the console in the window of the MXview Client.

Configuration Backup and Restoration (Moxa
devices only)

Take the following steps to back up a device’s configuration file to a local computer:

1. Select Device & Maintenance - Configuration = Load from Device.

2. Choose the location where you would like to save the file.

Take the following steps to restore a device’s configuration file:

1. Select Device & Configuration = Load to Device.

®% Load o Device 192.168.127 237 X

From File | | [ Browse ]

(o] ool ]

2. Choose the file and click OK.

Firmware upgrade

To up upgrade a device's firmware, select Device = Firmware Upgrade. The firmware will be uploaded to
and installed on the device.

Downloading the Firmyeare File,the operation mayr take several minutes Do not tum the power off or disconnect the network Please wait a moment!

NOTE After the firmware has been installed successfully, the device will restart. This action could take a few seconds.

Refresh Status

Since some device data is collected by polling, there may be a time delay for some data. To refresh a device to
get its updated status, select Device > Refresh.
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Mass Operation Configuration Export/Import
and Firmware Upgrade

MXview lets users export/import configuration and upgrade firmware in a mass deployment to a group of
devices.

Export Configurations from Multiple Devices

1. Select Tools = Configuration Center

% Configuration Center E]
V| MAC
List of Devices Location
192.168.127.1 - PT-7828 A
192.168.127.5 - SNMP Device List of Configurations
192 168.127.12 - EDS-4084 Filename Gt T Lt Chesking Time

192168127 27 -- ED3-4024
102.168.127 34 - EDE-4024
192.168.127 67 -- ICMP Device
192.168.127.85 -- ED3-5184
192.168.127 81 -- ICMPF Device
192.168.127.102 -- ICMF Device
192.168.127.103 -- ICMP Device
192.168.127.104 -- ED3-4024
192.168.127.105 -- ED3-4024
102.168.127.106 - EDS-4084
192.168.127.107 -- EDS-4084
192.168.127.109 -- ED3-4034
192.168.127.110 -- EDE-4034
192.168.127.111 -- EDE-4034
192.168.127.112 -- ED3-4084
192.168.127 112 -- ED3-4084
102.168.127.150 - AWEK-4121
192.168.127 162 -- EDS-4084
192.168.127.181 -- ICMF Device
192.168.127.182 -- ICMF Device
192.168.127.183 -- ICMF Device
192.168.127.200 -- SNMP Device

192.168.127 235 -- ED3-(3500

192168127 236 -- ED3-(3500

ANA AN 1A A9T T CAna

Export from Device l l Import to Device l

2. Click Export from Device
3. Select a folder in which to store configuration files

4. Select devices to export configuration files from and add them to the list. Click Export
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#% Export Confignration ﬁl
IP Addres: Status

192168127 34 SnncesE A
192168127 67 Exporting...
192168127 88 Taiting. ..
19216812791 Taiting. ..

193 .168.127.102 Taiting. ..
192.168.127.103 Taiting. ..

192 .168.127.104 Taiting. ..

192 .168.127.105 Taiting. ..

192 .168.127.106 Taiting. ..

192 .168.127.107 Taiting. ..

192 .168.127.109 Taiting. ..
192.168.127.110 Taiting. ..

192188127 111 Taiting. ..
192168127112 Taiting. ..
192168127113 Taiting. ..
192.168.127.150 Taiting. ..
192.168.127.162 Taiting. .. W

Cancel

After a few seconds, the configuration files will be exported to the designated folder, with IP addresses and
timestamps in the filenames.

Import a Configuration to Multiple Devices

Moxa switches can import a segment of a configuration file and change device configurations based on the

parameters the segment describes. MXview helps users import a segment of a configuration file to multiple
devices.

1. Select Tools = Configuration Center
2. Click Import to Device

3.
4

. Select devices to import configuration files to and add them to the list. Click Import

Select a configuration file segment

After a few seconds, the configuration file segment will be imported to devices and activated.

Upgrade Firmware on Multiple Devices

1. Select Information > Firmware Version

2. Click Upgrade

3.

4. Select devices that upgrade firmware and add to the list. Click Upgrade

Select a firmware file

The firmware will be upgraded to devices one by one. MXview will wait for 30 seconds before upgrading the
next device on the list, in order to give the upgrading devices sufficient time to finish the process.
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Scheduled Configuration Export/Import

1. Select Tools = Job Scheduler

X

List of Joh Information of Jok
Name of Joh:
Action of Joh:
Frequency of Joh:
Description of Joh:
[ Add Close
2. Click Add

3. Enter a job name and select Import Configuration or Export Configuration in the drop-down box.

(3

MName of Joh

Action of Joh

Description of Job

Step 1 - Job Information | Step 2 - Select Devices | Step 3 - Schedule Time

X

|dai|y_exp0rﬂ |

|Exp0r‘[ Configuration v|

Mext ] ’ Cancel
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4. Select the devices that apply and add them to the list. Click Next

5. Select the execution routine.

Configuration Change History and Comparison

When MXview exports configurations from devices, whether manually or by schedule, MXview will compare the
exported configuration with the last configuration exported and stored on the MXview server. If there is any
difference MXview will save the configuration on the MXview server. Users can then check the change history
of the configuration file:

1. Select Tools > Configuration Center

2. Check List of Configurations
And users can compare any 2 stored configurations at MXview server

1. Select Tools = Configuration Center
2. Click Compare
3. Select two IP addresses and their configurations

Change | 465 Delete 1877 Insert 0

B_192.168.127.88_20111226_1731.ini

5_192188.127.34_20111226_1730.ini

1: [EtherDevice Server Configuration File]
s
3 #hodel Name
4

i hodelMame EDS-518A-55-5C
B:

T

a

9:

10:

11:%# System Identification #

12:

13

14:

18:# [BwitchMName]: Switch Mame

16:

17.# --=max length = 30 words
18:

19: BwitchMame

20:

21

22

23:#[Location]: Switch Location

24:

25.# -=max. length = 80 words
26:

27: Location Switch Location

28:

29:

30:

31 # [BysDescr], Switch Description

32

33# -=max. length = 30 words

34:

35: SysDescr MOHA EDS-518A-55-8C

Managed Redundant Switch 00015

1: [EtherDevice Server Configuration File] e
s
3 #hodel Name
"

5 ModelMame EDS-408A
B:

T

a

9:

10:

11: # System Identification #

12:

13

14:

18: # [BwitchMName]: Switch Name

16:

17.# --=max. length = 30 words
18:

19: BwitchMame

20:

21

22

23 #[Location]: Switch Location

24:

25 # -=max. length = 80 words
26:

27: Location Switch Location
28:

29:

30:

31: # [BysDescr]: Switch Description

32

33# -=max. length = 30 words

34:

38. SysDescr EDS-408A

Managed Redundant Switch 03611

The inserted, deleted and modified lines in the configuration will be highlighted.

Device and Inventory Report

MXview can summarize device information in a formal report. Both a Device Availability Report and
Inventory Report are available.

Device Availability Report

The device availability report includes information about Device IP, Device Alias, Availability average, and
Availability worst data. You can narrow the report by a specific time period by dates and groups.

Select Information > Device Availability Report
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Availability Report
Availability Date Selection
Group  Any = Fram |201277/5 w| o~ To (201275 v
Device IP Device Aliag Fram date End date Availability & | Availabilit..| Davs
192.168.127.1 192.168.127.1 PT-7828 I012-07-05  2012-07-05 100000 100.000 1[m
192.168.127.12 192.168.127.12 EDS-4084 012-07-05  2012-07-05 100000 100.000 1
192.168.127.27 192.168.127.27 EDS- 4084 012-07-05  2012-07-05 100000 100.000 1
192.168.127.41 182.168.127.41 EDS-408A 012-07-05  2012-07-05 100000 100.000 1
192.168.127.42 192.168.127 42 EDS-408A a012-07-05  2012-07-05 100000 100.000 1
192.168.127.44 192.168.127 44 EDS-4084 012-07-05  2012-07-05 100000 100.000 1
192.168.127.43 192.168.127.43 EDS- 4084 012-07-05  2012-07-05 100000 100.000 1
192.166.127.46 182.168.127 46 EDS-408A 012-07-05  2012-07-05 100000 100.000 1
192.166.127.45 192.166.127 45 EDS-408A 012-07-05  2012-07-05 100000 100.000 1
192.168.127.61 192.168.127 61 EDS-4084 012-07-05  2012-07-05 100000 100.000 1
192.168.127.62 192.168.127 62 EDS- 4084 012-07-05  2012-07-05 100000 100.000 1
192.168.127.65 182.168.127.65 PT-510 012-07-05  2012-07-05 100000 100.000 1
192.168.127.112 182.168.127.112 IKS-6726 Series  2012-07-05  2012-07-05 100000 100.000 1
192.168.127.155 192.168.127 155 EDS-4084 012-07-05  2012-07-05 100000 100.000 1
192.168.127.156 192.168.127.156 EDS-5084 012-07-05  2012-07-05 100000 100.000 1
192.168.127.160 182.168.127.160 EDS-408A 012-07-05  2012-07-05 100000 100.000 1
192.168.127.164 182.168.127 164 EDS- 4084 2012-07-05  2012-07-05 100000 100.000 1
192.168.127.162 192.168.127 162 EDS-5084 012-07-05  2012-07-05 100000 100.000 1
192.168.127.115 192.168.127.115 ICMP Device 012-07-05  2012-07-05 B.715 6.715 1
192.168.127.250 182.168.127.250 EDS-510A 012-07-05  2012-07-05 100000 100.000 1
192.168.127.153 182.168.127 153 ICMP Device 2012-07-05  2012-07-05 100000 100.000 1
192.168.127.251 192.168.127.251 EDS-5184 012-07-05  2012-07-05 100000 100.000 1
192.168.127.181 192.168.127.181 ICMP Device 012-07-05  2012-07-05 100000 100.000 1
192.168.127.152 182.168.127.162 ICMP Device 012-07-05  2012-07-05 100000 100.000 1
192.168.127.183 182.168.127 183 ICMP Device 2012-07-05  2012-07-05 17.588 17.588 1
192.168.127.240 182.168.127.240 PT-7528 012-07-05  2012-07-05 100000 100.000 1
AN AED 497 28D AN AED 427 2D 0 2000 049 N7 NE N4 N7 NE =ik N4 =k 4 Ll
I Exportto GV l [ Export to FOF ] [ Close

The availability report can be exported to a PDF or CSV file.

Availability Report

From date:2012-07-05

Report Generate dare:2012-07-05 End date:2012-07-05
Device IP |Device Aliaz isbility Average |Availability Worst |Fromdate  [End date Days
1921681271 192.168.127.1 PT-7828 100.000| 100.000(2012-07-05  [2012-07-05 1
192.168.127.12 192.168.127.12 EDS-4084 100.000] 100.000(2012-07-05  [2012-07-05 1
192.168.127.27 192.168.127.27 EDS-4084 100.000] 100.000(2012-07-05  |2012-07-05 1
19216812741 192168127 41 EDS408A 100.000 100.000(2012-07-05 1
192.168.127.42 192.168.127.42 EDS408A 100.0001 100.000(201207-05  |2012-07-05 1
192168.127.44 192 168.127 44 EDS-4084 100.000] 100.000(2012-07-05  [2012-07-05 1
192.168.127.43 192.168.127 43 EDS-4084 100.000| 100.000(2012-07-05  [2012-07-05 1
192.168.127.46 192.168.127.46 EDS-4084 100.000] 100.000(2012-07-05  |2012-07-05 1
192.168.127.45 192.168.127.45 EDS4084 100.000] 100.000|2012-07-05  [2012-07-05 1
192.168.127.61 192.168.127.61 EDS-408A 100.000] 100.000(20120705  |2012-07-05 1
192.168.127.62 192.168.127.62 EDS408A 100.0001 100.000(201207-05  |2012-07-05 1
192.168.127.65 192 168.127 65 PT-510 100.000| 100.000(2012-07-05  [2012-07-05 1
192168127112 (192.168.127.112 TES-6726 Series 100.000| 100.000(2012-07-05  [2012-07-05 1
192.168.127.155  [152.168.127.155 EDS-4084 100.000] 100.000(2012-07-05  |2012-07-05 1
192.168.127.156  [192.168.127.156 EDS-5084 100.000] 100.000|2012-07-05  [2012-07-05 1
192.168.127.160  [192.168.127.160 EDS-408A 100.0001 100.000(201207-05  |2012-07-05 1
192.168.127.164  [152.168.127.164 EDS-408A 100.000] 100.000(2012-07-05  [2012-07-05 1
192168127162  [192.168.127.162 EDS-5084 100.000| 100.000(2012-07-05  [2012-07-05 1
192168127115 [192.168.127.115 ICMP Device 6715 6715|2012-07-05  [2012-07-05 1
192.168.127.250  [192.168.127.250 EDS-5104 100.000] 100.000(2012-07-05  |2012-07-05 1
192.168.127.153  [192.168.127.153 ICMP Device 100.000] 100.000|2012-07-05  [2012-07-05 1
192.168.127.251  (192.168.127.251 EDS-518A 100.0001 100.000(201207-05  |2012-07-05 1
192.168.127.181  (192.168.127.181 ICMP Device 100.000] 100.000(2012-07-05  [2012-07-05 1
192168127182 [192.168.127.182 ICMP Device 100.000| 100.000(2012-07-05  [2012-07-05 1
192168127 183 192 168 127183 ICMP Device 17588 17.588(2012-07-05  |2012-07-05 1
192.168.127.240  [192.168.127.240 PT-7528 100.000] 100.000|2012-07-05  [2012-07-05 1
192168127253 [192.168.127.253 1CS-G7828 6715 6.715|2012-07-05  [2012-07-03 1
192.168.127.248  [192.168.127.248 ICMP Device 100.0001 100.000(201207-05  |2012-07-05 1
192.168.127.243  [152.168.127.249 ICMP Device 100.000] 100.000(2012-07-05  |2012-07-05 1
192168127254  [192.168.127.254 ICMP Device 100 OD—D| 100.000(2012-07-05  [2012-07-05 1
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By default, the
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A

Device availabiliti _|

Device [P
192.168.127.1
192.168.127.12
192.168.127.27
192.168.127.41
192.168.127.42
192.168.127.44
192.168.127.43
192.168.1277.46
192.168.127.45
192.168.127.61
192.168.127.62
192.168.127.65
192.168.127.112
192.168.127.155
192.168.127.156
192.168.127.160
192.168.127.164
192.168.127.162
192.168.127.115
192.168.127.250
192.168.127.153
192.168.127.251
192.168.127.181
192.168.127.182
192.168.127.183
192.168.127.240
192.168.127.253
192.168.127.248
192.168.127.249
192.168.127.254

Device Alias

192.168.127.1 PT-7828
192.168.127.12 EDS 408 A
192.168.127.27 EDS 4084
192.168.127 41 EDS-4084A
192.168.127 42 EDS408A
192.168.127 44 EDS4084
192.168.127 43 EDS 4084
192.168.127 46 EDS408A
192.168.12745 EDS 4084
192.168.127.61 EDS-4084A
192.168.127 62 EDS 4084
192.168.127.65 PT-510
192.168.127.112 IR S 6726 Series
192.168.127.155 EDS-4084
192.168.127.156 EDS-5084
192.168.127.160 EDE-4084
192.168.127.164 EDS-4084
192.168.127.162 EDS-5084
192.168.127.115 ICMP Device
192.168.127.250 EDE-5104
192.168.127.153 ICMF Device
192.168.127 251 EDS-5184
192.168.127.181 ICMP Device
192.168.127.182 ICMP Device
192.168.127.183 ICMF Device
192.168.127.240 PT-1528
192.168.127.233 ICE-G7828
192.168.127.248 ICMP Device
192.168.127.249 ICMP Device
192.168.127.254 ICMP Device

5 D

Availability Average Availability Worst From date End date Days

100
100
100
100
100
100
100
100
100
100
100
100
100
100
100
100
100
100
6.715
100
100
100
100
100
17.588
100
6.715
100
100
100

100
100
100
100
100
100
100
100
100
100
100
100
100
100
100
100
100
100
6.715
100
100
100
100
100
17.588
100
6.715
100
100
100

2012745
20127745
20121715
20121715
20121715
2012075
2012745
20127745
20121715
20121715
2012075
2012745
20127745
20121715
20121715
20121715
2012075
2012745
20127745
20121715
20121715
2012075
2012745
20127745
20121715
20121715
20121715
2012075
2012745
20127745

2012745
20127745
20121715
20121715
20121715
2012075
2012745
20127745
20121715
20121715
2012075
2012745
20127745
20121715
20121715
20121715
2012075
2012745
20127745
20121715
20121715
2012075
2012745
20127745
20121715
20121715
20121715
2012075
2012745
20127745

G

U PRI R V) PRI R RN [V U PR R (R YR PR (R R [V R (R PR PR U U (R (R PR R P [y Py

availability is calculated based on 24-hour intervals. To change this, in the menu select
Project > Preferences >Advanced > Devices > Timeframe for availability calculation

Enter the calculation timeframe base in the box and click OK. Units are entered in hours..

Inventory Report

Select Information >Inventory Report to generate an inventory report.

Inventory report provides a summary of each device’s properties. With Inventory Report, MXview will export
reports separately for all the devices in your network. Each device has a single PDF Report. The PDF filename
is determined by device IP. The title of the report is the device alias, which you can edit in MXview. If there is
any third-party MIB compiled in, the proprietary information will be included into the report (refer to Chapter

13- MIB).
o8 =10
File Edit View Window Help x
ﬁ} @ Z B @ | * {3 | =) (e | = Tools | Sign | Comment
L Matt's Switch #2
Report Generate date: 2012-06-06

Property Value s

P 192.168.127.12

Device Alias Matt's Switch #2

MAC Address 0090ES819290B

sysDescr MOXA EDS-408A

sysObjectld 136141860177

sysContact 80191230

sysName Managed Redundant Switch 07022

sysLocation Matt's Desk

mode]Name EDS-408A

firmwareVersion V3.0 build 11070113

IpMask 2552552550

defaultGateway 0000

dnsServerlIpAddr 0000

snmpTrapCommunity public LI
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VLAN/IGMP Snooping

VLAN Visualization

Moxa switches support 802.1Q tagged VLAN. MXview collects each device’s VLAN configuration and integrates
the information with color-coded visualization to provide a network-wide view.

1.

Click the VLAN icon in the topology toolbox.

S S 0

I

2. After selecting a specific VLAN ID, devices, ports and links that are associated with the ID will be

color-coded.

To view the VLAN information in a table format, select Network - VLAN

wx YLAN

B802.10) ]'Pnn-based ]

x)

Device P tadel Lacation WLAR 1D Joined Acces.. Joined T Manage..
182168127103 (Managed factory 1 1,2,3448678, . I PN
182168127102 [Managed Red... |Switch Locat.. |1 1,2,345678,.. I T
189216812770 |Moxa EDS-51... |Switch Locat.. |1 1,2,345678,.. I
192.168.127 69 |Moxa EDS-51... |Switch Locat.. |1 123458678, I
1892168127 68 |Moxa EDS-51... |Switch Locat. |1 1,2,34,5678,. M
182168127 67  |Moxa EDS-51... |Switch Locat. |1 12345678, . M
182168127 66 |[Moxa EDS-51.. |Switch Locat. |1 1,23448678, . I
182.168.127 65 |Moxa EDS-51... |Switch Locat.. |1 1,2,345678,.. I
1892.168.127 64 |Moxa EDS-51... |Switch Locat.. |1 1,2,3445678,.. I
192.168.127 63  |Moxa EDS-51... |Switch Locat.. |1 123458678, I
182168127 62 |Moxa EDS-51... |Switch Locat. |1 12345678, . M
182168127 61 |Moxa EDS-51... |Switch Locat. |1 123478491, M
18216812714 |Moxa EDS-51... |factory 1 12345691, I
189216812713  |Managed Red...|factony 1 1,2,345678,.. I
189216812712  |Moxa EDS-40... |Switch Locat.. 1 1,2,345678, I
19216812711  |Managed Red...|Switch Locat... 1 1,2,3458678,.. 1§
1821681272 Moxa PT-7828. |factory 1 27,28 Tk, M =
1821A8.127 .1 Managed Red... [factony 1 91011,1213 .. I b

Close
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IGMP Snooping Visualization

Moxa switches support IGMP snooping. MXview collects each device’s IGMP snooping configuration and
visualizes the information to provide a network-wide view.

1. Click the IGMP icon in the topology toolbox.

X ["’ ['II-' I.—I-. I' .fVmEE.

2. After selecting a specific VLAN ID and multicast address, devices, ports and links that are associated with

the stream will be color-coded.
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MIB

MXview’s embedded MIB compiler supports third-party MIB files. After compiling the MIB file, any device’s
parameter can be monitored in MXview.

This chapter covers the following application tools of the MIB compiler:

O MIB Browser
0 OID Import Manager
O Trap Import Manager

MOB browser provides an easy and comfortable browsing interface for reading proprietary MIB parameters.
OID import manager makes all monitored parameters customizable, and they can be read in the device
properties window list. With Trap Import Manager, the third-party traps can be displayed in the event history
box.
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MIB Browser

MIB Browser is a simple and fast interface that lets you browse MIB files. It is able to load third-party MIB files.
After loading the MIB, the OID tree will be listed in the left column. You can unfold these OIDs and get the
parameter you need.

To open the MIB Browser: Select MIB ->MIB Browser

=100 x|
File  About
| ) RFCLIL3-MIB
) OLD-CIECO-CPUMIE AgentlP:  [192.168.127.252 SNMP v1
£ VALUES
Y ol 1361419221166
B busyPer (56)
8 avgBusyl (57) Get | GetNext | Get Subtiee | Walk | Set
M augBusys (58)
2 ill-Count (59) Hame/OID alns
> illeWized {60} uter 3 =
avgBusyl 4
avgBusys 3
I@acﬂnm 83
idle Wired. 0

136141921610 |vis Sysiems, ur.170 West Tosman Dr.Sen Jose, CA 05134-17060 5.4 Ph +1-408-526-40
136141021620  [18024

136141921630 0
136141921640
136141921650
136141921660
136141021670
13614192160
136141921690
womeJepu (1) 136141921700
oD 136141921 136141921710
(VALUE lepu 0BUECT | | (136141921720 0000
description |DENTIFIER 136141921730 [flash/e0950-i6qd1-mz 12111 EAL bin
138441924 | (136141921740 |3

1361419231111 [Fast Blhemmet
1361419231113 [Fost Blhemmet
1361419221112 [Fast Elhemet -

EIE'E Close
e C(lick File >Load MIB to load a MIB file.
e Select the item in the MIB tree:

e Click Get to get the parameter of selected item.

¢ Click Get Next to get the OID next to the item you selected.
e Click Get Subtree to get all the OIDs in the subtree folder.
e Click Walk to get the OID’s parameter in sequence.

e Click Set to set up parameters of the selected OID.

OID Import Manager

OID Import manager helps to add specific OID items for SNMP polling. It supports third-party MIB with polling.
After compiling the MIB files, you can monitor third-party OIDs through SNMP polling.

To open the import manager: Select MIB > OID Import Manager

& OID Import Manager !. H

List of Polling OIDs

R Vil Show Details
CP1 av gBusy5 136141921580
CPU avgBusyl 136141821570 Assign
CPU busyPer 136141921560
CP1 idle Wired 136141921600
CP1 dleCount 136141921590

Modify
Delete

Close

¢ List of Polling OIDs lists all specific polling items.
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¢ Click Show Details to see the OID name, OID, and the devices which this OID is assigned to.
e Click Add to add an OID form the standard MIB or a third party MIB
e Click Modify to modify an imported OID’s name.

e C(Click Delete to remove an imported OID
There are two steps to add a new OID and assign it to the specific device.

1. Add a specific OID

Click Add to add a new OID for polling. A window will pop up. You can import MIB files by selecting File > Load
MIB. In this window you can edit the Name for the OID you selected. This name will be displayed in the device
properties window.

o R ==

File

RFCI213-MIB
=] TALUES
= 1 mib-2 1)
- ) sysem (1)
intexfaces (2}
at (%)

icmp (5)

Name

ip
oD
1361214

Operation

® tet

Index

tp (6)

udp (7)

eep )
transmission (10)
anmp (1)

- E-E-E-E-E

e

Name
Value

&

OID Description

VALUE ip OBJECT IDENTIFIER
=1.36.1.2.1.4

[ Add [ Cancel ]

Click the Test button to try to get the OID parameter first. You can find the description for this OID in the OID
description window. Click the Add button to add this OID into the import manager.

2. Assign polling OID to the device

Click the Assign button in OID import manager. An Assign Polled Devices window will pop up.

Ea. Assign Polled Devices

MName iplnDelivers OID | 136121480

AL
List of Devices

192.168.127.36 (192.168.127 36 ICMP Device)
192.168.127.38 (192.168.127 38 ICMP Device) Add

List of Belected Devices
192.168.127.3 (192.168.127.3 ED3-4084)
192.168.127.4 {192.168.127 4 ED3-4084)

192.168.127 253 (192.168 127 253 TKS-36524)
Add All

Remove

Remove All

This window will list all devices in the network. Select the device you wish to assign then click Add. The selected
device will be moved to the right. After selecting the device, click Assign to finish.

After adding a device, click the device in the main screen. The third-party MIB OID can be read in the device
property window.
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Device Properties
[H-® interface. 20 down 4 10H / ﬂ
[-m interface.Z1 dowm / 10M 7
[H-m| interface, 22 dowm / 10M 7
(- interface. 23 dowm / 10M 7
- interface. 24 dowm 4 100M
- interface. 28 down 4 10M /
- interface.Za down 4 10H /
[#-® interface.z27 up Fo=1 )
- interface, 28 up 416
""" £% ipadEntaddre. 192, 165,127,252 192.1
----- "";3 CPU. busyPer 1
----- % CPU.L avgBusyl 4
----- % CPU.L avgBusys 4
----- % CPU.idleCount 4936
----- o CRULidleWired 0 -
4 3

Trap Import Manager

Trap Import Manager can read third-party MIB files, and compile the MIB into MXview. With this tool, MXview
can understand traps from third-party MIBs.

To open the trap import manager, select MIB >Trap Import Manager

7 Trap Import Manager g@

List of Traps
Nams Trsp OID Show Details
¢2000R psFailed T4 70
2000E roadeastitomm 1361410087202
2900 ddress¥iolation 1361410087201

Impart

todify Description

Delete

Close

The list of traps column will list all the traps which are already imported.
Click Show Details to read detailed information, including Trap Name, OID, and its descriptions.
Click Import to load MIB files and select the trap to import.

Click Modify Description to name the description for the Trap. The description here will be the trap event
which shows in the event list.

Click Delete to remove an imported Trap.

There are three steps to add a new Trap to MXview.

1.

Load a MIB

Click the Import button. The Import Dialog window will pop up. Then click Load MIB and select a MIB file to
load.

After the MIB is loaded, click Parse. The column on the right will list all the Traps.
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i
~
Load MIE ] [ Remove MIE ] c2800AddressVianlation c2800AddressViolation D
CISCO-C2900-MIB.rmy
£2800Broadeaststarm £2800Broadcaststarm D
c2900RpsFailed £2900RpsFailed D
linkDawn linkDawn D
linkUp linkUp G
coldStart coldStart D
warmStart warmStart D
fase ] authenticationF ailure authenticationF ailure D
P

Tmnport Cancel

2. Select Trap to import

Select the check box corresponding to the Trap you would like to import.
Click the button behind each Trap to show its OID and the original description of its MIB.

(& ¢2900Add ressViolation
oID 1.361.41.9.987.201
Enterprise 13514199872
VALTE c29004dd ressViolation NOTIFICATION TYFE ( ~

Objects: [1,3.6.1.4.1,8,9.87.1.4.1.1.25]

Status: current

Description: The address¥iclation notification is generated
when an address violation 1z detected
on a secured port. The generation of the
addressVielation notification can be enabled
or suppressed using the ohject
c2900Cenfigaddress¥iolatlondction,
The particular secured port 1s Indicated by

the walua nf ~2600Part]finday L]

Clase

3. Edit description

In the Trap list, the description field is editable. You are able to write a customized description here.
c2800AddressWiolation

A 29004ddressviolation D

When finished, click the Import button. The dialog will be closed and returned to the Trap Import Manager
window. You will find imported Traps in your List.
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75 Trap Import Manager g@

List of Traps
e Trsp OID Show Details
¢ 2000R p<Failed TR TA T T
2900 Bixoad castitom 1361419987202
2900 4dd ressViolstion 1361419957201

Import
Modify Description

Delete

Close

NOTE The system will notify you with a pop-up window if an OID has already been imported.

Information

X

\lr) " 2900 AddressVinkstion” is already known
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MXview License

MXview is available in different versions, which the different versions supporting different numbers of nodes.
For example, if your version of MXview supports 250 nodes, then during device discovery MXview will only
recognize up to 250 nodes. MXview will stop the device discovery procedure once it reaches the 250-node limit.

The MXview license that you purchase specifies the node limit for that version of MXview. To increase the node
limit, you can purchase license upgrade and import the upgrade into MXview.

Checking the License

The number of currently managed nodes and the node limit is shown in the Status Bar on the Dashboard.

The Mumhber of Managed Devices /dax 24 140

To check the details, select Help = License.

Mumber of Managed Devices [ Max

Editinn Eexw Aotivation Time Add License

Commercisl-500 |DYFHLHAU77CEDF3N4MFS WIST A6 [2009-11-04 11:52:06

Close

License Upgrade

To increase the node limit of your MXview, you need upgrade the license.

1. Select Help = License.
2. Click Add License.

WE License § |

mMumber of Manaded Devices f Max

Editiomn Kew Activation Time Add License

Corumercial-500 [DYFHLHAU77CRDP3N4MFS WIST A6 [2009-11-04 11:52:08

Close




MXview MXview License

3. Find the license label in the software package, which is shown as:

MXview Upgrade-50
Key: XOOKXIK KA XX XI KA KXKKXXK

4. Enter the key of the new license and click OK.
X

Input License Key

(o] (oo |

5. Restart the MXview client.
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FAQ

Why do events show up late?
Make sure you have configured your switches’ SNMP trap server to the MXview server’s IP address, since doing
so will provide real-time responses to events. Otherwise, MXview will collect information periodically.

Why can’t I discover all of the devices on my network?

Please check the following:

1. Make sure your license supports a sufficient number of nodes.
2. Make sure your scan range includes all of the IP addresses of devices on your network.

Make sure your switches do not go into protection mode because they consider MXview packets to be part
of a broadcast storm.

Why does one device have more than one icon?

MXview identifies devices by IP address. For this reason, if one device has more than one IP address within the
scan range, the device will be viewed as multiple devices.

Will deleting a link in MXview cause the link to be disconnected in the real
network?

No. The topology map shows the status of the real network, but cannot be used to configure the real network.

After a link in a ring is disconnected, why does it take a few seconds for the
redundant link to become solid in the topology map?

MXview uses polling to determine if redundant links have become non-redundant. For this reason, the topology
map will not be updated until all devices in the network have been polled. In addition, since it takes a finite
amount of time to transmit the network status to the MXview server, it will take at least that amount of time for
the topology map to be updated.
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License (Net-SNMP)

Various copyrights apply to this package, listed in several separate sections below.

Please carefully review all sections of the license information.

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000. The Regents of the University of California

All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and without
fee is hereby granted, provided that the above copyright notice appears in all copies and that both that
copyright notice and this permission notice appear in supporting documentation, and that the name of CMU and
The Regents of the University of California not be used in advertising or publicity pertaining to distribution of
the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES WITH REGARD TO
THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT
SHALL CMU OR THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT
OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA
OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----

Copyright (c) 2001-2003, Networks Associates Technology, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.
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* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be used
to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from this
software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright © 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara,

California 95054, U.S.A. All rights reserved.

Use is subject to license terms below.
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This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----

Copyright (c) 2003-2009, Sparta, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
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(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network
Center of Beijing University of Posts and Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of their
contributors may be used to endorse or promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT HOLDERS OR

CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY,

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----

Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003
oss@fabasoft.com

Author: Bernhard Penz

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
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* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names may
not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 8: Apple Inc. copyright notice (BSD) -----

Copyright (c) 2007 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple”) nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL APPLE OR ITS CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 9: Sciencelogic, LLC copyright notice (BSD) -----

Copyright (c) 2009, Sciencelogic, LLC

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
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* Neither the name of SciencelLogic, LLC nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS"” AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The MIT License (Libxml2)

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the “Software”), to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and
to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of
the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE
FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

License Agreement (GoAhead)

THIS LICENSE AGREEMENT IS BETWEEN YOU AND GOAHEAD (BOTH AS DEFINED BELOW). THIS AGREEMENT
GRANTS YOU ONLY A LIMITED LICENSE TO USE GOAHEAD PROPRIETARY COMPUTER SOFTWARE. BY
EXECUTING THIS AGREEMENT OR USING THE SOFTWARE, YOU CERTIFY THAT YOU WILL USE THE SOFTWARE
ONLY IN THE MANNER PERMITTED HEREIN.

1. Definitions.

“Documentation” means any documentation GoAhead provides with the Original Code.
“"GoAhead” means GoAhead Software, Inc.

“Agreement” means this document.

“Modifications” means any addition to or deletion from the substance or structure of either the Original Code
or any previous Modifications.

“Original Code” means the source code to GoAhead’s proprietary computer software entitled GoAhead
WebServer that is provided to You by GoAhead.

“You” means an individual or a legal entity exercising rights under, and complying with all of the terms of, this
license or a future version of this license. For legal entities, “You” includes any entity that controls, is controlled
by, or is under common control with You. For purposes of this definition, “control” means (a) the power, direct
or indirect, to cause the direction or management of such entity, whether by contract or otherwise, or (b)
ownership of fifty percent (50%) or more of the outstanding shares or beneficial ownership of such entity.
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“Response Header” means the first portion of the response message output by the GoAhead WebServer,
containing but not limited to, header fields for date, content-type, server identification and cache control.

“Server Identification Field” means the field in the Response Header which contains the text “Server:
GoAhead-Webs".

2. License.
Limited Original Code Grant.

Subject to the terms of this Agreement, GoAhead hereby grants You a worldwide, royalty-free, nonexclusive,
nontransferable license, without right of sublicense, subject to third party intellectual property claims, (a) to
use and reproduce the Original Code, (b) to create Modifications from the Original Code, and (c) to distribute
source code copies of the Original Code form solely when embedded in other software (in a manner that does
not allow the Original Code to be separated) that provides material functionality in addition to the functionality
provided by the Original Code.

Binary Code.

Subject to the terms of this Agreement, GoAhead hereby grants You a worldwide, royalty-free, nonexclusive,
nontransferable license, without right of sublicense, to copy and distribute binary code copies of the Original
Code together with Your Modifications in binary code.

Restrictions on Use.

You may sublicense third parties to use Your Modifications if You enter into a license agreement with such third
parties that bind such third parties to all the obligations under this Agreement applicable to You and that are
otherwise substantially similar in scope and application to this Agreement (without limiting the protections
afforded to GoAhead). You may not rent, lease, or loan the software.

Documentation.

Subject to the terms of this Agreement, GoAhead hereby grants You a worldwide, royalty-free, nonexclusive,
nontransferable license, without right of sublicense, to copy and distribute the Documentation in connection
with the authorized distribution of the Original Code and Modifications.

Copyright Notice.

You agree to include copies of the following notice (the “Notice”) regarding proprietary rights in all copies of the
Original Code and Modifications that You distribute, as follows: (a) embedded in the binary code; and (b) on the
title pages of all documentation. Furthermore, You agree to use commercially reasonable efforts to cause any
licensees of your products to embed the Notice in object code and on the title pages or relevant documentation.
The Notice is as follows: Copyright (c) 20XX GoAhead Software, Inc. All Rights Reserved. Unless GoAhead
otherwise instructs, the year 20xx is to be replaced with the year during which the release of the Original Code
containing the notice is issued by GoAhead. If this year is not supplied with Documentation, GoAhead will
supply it upon request.

License Back to GoAhead.

You hereby grant in both source code and binary code to GoAhead a world-wide, royalty-free, non-exclusive
license to copy, modify, display, use and sublicense any Modifications You make that are distributed or planned
for distribution. Within 30 days of either such event, You agree to ship to GoAhead a file containing the
Modifications (in a media to be determined by the parties), including any programmers’ notes and other
programmers’ materials. Additionally, You will provide to GoAhead a complete description of the product, the
product code or model number, the date on which the product is initially shipped, and a contact name, phone
number and e-mail address for future correspondence. GoAhead will keep confidential all data specifically
marked as such.

3. Terms, Trademards and Brand.
License and Use.

GoAhead hereby grants to You a limited world-wide, royalty-free, non-exclusive license to use the GoAhead
trade names, trademarks, logos, service marks and product designations posted in Exhibit A (collectively, the
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“GoAhead Marks") in connection with the activities by You under this Agreement. Additionally, GoAhead grants
You a license under the terms above to such GoAhead trademarks as shall be identified at a URL (the “URL")
provided by GoAhead. The use by You of GoAhead Marks shall be in accordance with GoAhead’s trademark
policies regarding trademark usage as established at the Web site designated by the URL, or as otherwise
communicated to You by GoAhead at its sole discretion. You understand and agree that any use of GoAhead
Marks in connection with this Agreement shall not create any right, title or interest in or to such GoAhead Marks
and that all such use and goodwill associated with GoAhead Marks will inure to the benefit of GoAhead.

Promotion by You of GoAhead WebServer Mark.

In consideration for the licenses granted by GoAhead to You herein, You agree to notify GoAhead when You
incorporate the GoAhead WebServer in Your product and to inform GoAhead when such product begins to ship.
You agree to promote the Original Code by prominently and visibly displaying a graphic of the GoAhead
WebServer mark on the initial Web page of Your product that is displayed each time a user connects to it. You
also agree that GoAhead may identify your company as a user of the GoAhead WebServer by placing your
company logo on its Web site. You may further promote the Original Code by displaying the GoAhead
WebServer mark in marketing and promotional materials such as the home page of your Web site or Web pages
promoting the product. You also agree to use the latest available logo and script code from GoAhead available
from the official GoAhead download location.

No Modifications to Server Identification Field.

You agree not to remove or modify the Server identification Field contained in the Response Header as defined
in Section 1.7 and 1.8.

4. Term.

This Agreement and license are effective from the time You execute this Agreement until this Agreement is
terminated. You may terminate this Agreement at any time by uninstalling or destroying all copies of the
Original Code including all binary versions and removing any Modifications to the Original Code existing in any
products. This Agreement will terminate immediately and without further notice if You fail to comply with any
provision of this Agreement. All restrictions on use, and all other provisions that may reasonably be interpreted
to survive termination of this Agreement, will survive termination of this Agreement for any reason. Upon
termination, You agree to uninstall or destroy all copies of the Original Code, Modifications, and
Documentation.

5. Warranty Disclaimers.

THE ORIGINAL CODE, THE DOCUMENTATION, AND THE MEDIA UPON WHICH THE ORIGINAL CODE IS
RECORDED (IF ANY) ARE PROVIDED “AS IS” AND WITHOUT WARRANTIES OF ANY KIND, EXPRESS,
STATUTORY OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND NON-INFRINGEMENT.

The entire risk as to the quality and performance of the Original Code (including any Modifications You make)
and the Documentation is with You. Should the Original Code or the Documentation prove defective, You (and
not GoAhead or its distributors, licensors or dealers) assume the entire cost of all necessary servicing or repair.
GoAhead does not warrant that the functions contained in the Original Code will meet your requirements or
operate in the combination that You may select for use, that the operation of the Original Code will be
uninterrupted or error free, or that defects in the Original Code will be corrected. No oral or written statement
by GoAhead or by a representative of GoAhead shall create a warranty or increase the scope of this warranty.

GOAHEAD DOES NOT WARRANT THE ORIGINAL CODE AGAINST INFRINGEMENT OR THE LIKE WITH RESPECT
TO ANY COPYRIGHT, PATENT, TRADE SECRET, TRADEMARK OR OTHER PROPRIETARY OR INTELLECTUAL
PROPERTY RIGHT OF ANY THIRD PARTY AND DOES NOT WARRANT THAT THE ORIGINAL CODE DOES NOT
INCLUDE ANY VIRUS, SOFTWARE ROUTINE OR OTHER SOFTWARE DESIGNED TO PERMIT UNAUTHORIZED
ACCESS, TO DISABLE, ERASE OR OTHERWISE HARM SOFTWARE, HARDWARE OR DATA, OR TO PERFORM ANY
OTHER SUCH ACTIONS.

Any warranties that by law survive the foregoing disclaimers shall terminate 90 days from the date You
received the Original Code.
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6. Limitation of Liability.

YOUR SOLE REMEDIES AND GOAHEAD'S ENTIRE LIABILITY ARE SET FORTH ABOVE. IN NO EVENT WILL
GOAHEAD OR ITS DISTRIBUTORS OR DEALERS BE LIABLE FOR DIRECT, INDIRECT, INCIDENTAL OR
CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF THE ORIGINAL CODE, THE INABILITY TO USE THE
ORIGINAL CODE, OR ANY DEFECT IN THE ORIGINAL CODE, INCLUDING ANY LOST PROFITS, EVEN IF THEY
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

You agree that GoAhead and its distributors and dealers will not be LIABLE for defense or indemnity with
respect to any claim against You by any third party arising from your possession or use of the Original Code or
the Documentation.

In no event will GoAhead's total liability to You for all damages, losses, and causes of action (whether in
contract, tort, including negligence, or otherwise) exceed the amount You paid for this product.

SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, AND SOME
STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO
THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS AND YOU MAY HAVE OTHER RIGHTS THAT VARY FROM STATE TO STATE.

7. Indemnification by You.

You agree to indemnify and hold GoAhead harmless against any and all claims, losses, damages and costs
(including legal expenses and reasonable counsel fees) arising out of any claim of a third party with respect to
the contents of the Your products, and any intellectual property rights or other rights or interests related
thereto.

8. High-Risk Activities.

The Original Code is not fault-tolerant and is not designed, manufactured or intended for use or resale as online
control equipment in hazardous environments requiring fail-safe performance, such as in the operation of
nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life support machines
or weapons systems, in which the failure of the Original Code could lead directly to death, personal injury, or
severe physical or environmental damage. GoAhead and its suppliers specifically disclaim any express or
implied warranty of fitness for any high-risk uses listed above.

9. Government Restricted Rights.

For units of the Department of Defense, use, duplication, or disclosure by the Government is subject to
restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software
clause at DFARS 252.227-7013. Contractor/manufacturer is GoAhead Software, Inc., 10900 N.E. 8th Street,
Suite 1200, Bellevue, Washington 98004.

If the Commercial Computer Software Restricted rights clause at FAR 52.227-19 or its successors apply, the
Software and Documentation constitute restricted computer software as defined in that clause and the
Government shall not have the license for published software set forth in subparagraph (c)(3) of that clause.

The Original Code (i) was developed at private expense, and no part of it was developed with governmental
funds; (ii) is a trade secret of GoAhead (or its licensor(s)) for all purposes of the Freedom of Information Act;
(i) is “restricted computer software” subject to limited utilization as provided in the contract between the
vendor and the governmental entity; and (iv) in all respects is proprietary data belonging solely to GoAhead (or
its licensor(s)).

10. Governing Law and Interpretation.

This Agreement shall be interpreted under and governed by the laws of the State of Washington, without
regard to its rules governing the conflict of laws. You hereby consent to the exclusive jurisdiction of the state
and federal courts located in King County, Washington over any disputes arising out of related to this
Agreement. If any provision of this Agreement is held illegal or unenforceable by a court or tribunal of
competent jurisdiction, the remaining provisions of this Agreement shall remain in effect and the invalid
provision deemed modified to the least degree necessary to remedy such invalidity.

11. Entire Agreement.
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This Agreement is the complete agreement between GoAhead and You and supersedes all prior agreements,
oral or written, with respect to the subject matter hereof.

License (OpenSSL)

This is a copy of the current LICENSE file inside the CVS repository.

LICENSE ISSUES

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the original
SSLeay license apply to the toolkit.

See below for the actual license texts. Actually both licenses are BSD-style Open Source licenses. In case of any
license issues related to OpenSSL please contact openssl-core@openssl.org.

OpenSSL License

* Copyright (c) 1998-2008 The OpenSSL Project. All rights reserved.

* Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgment: “This product includes software developed by the OpenSSL Project for use in the
OpenSSL Toolkit. (http://www.openssl.org/)”

4. The names “"OpenSSL Toolkit” and "OpenSSL Project” must not be used to endorse or promote products
derived from this software without prior written permission. For written permission, please contact
openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL” nor may “"OpenSSL” appear in their
names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: “This product includes
software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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* This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are aheared to.
The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code;
not just the SSL code. The SSL documentation included with this distribution is covered by the same copyright
terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

* Copyright remains Eric Young'’s, and as such any Copyright notices in the code are not to be removed.

* If this package is used in a product, Eric Young should be given attribution as the author of the parts of the
library used.

* This can be in the form of a textual message at program startup or in documentation (online or textual)
provided with the package.

* Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: “This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com)”The word “cryptographic” can be left out if the rouines from the library being used are
not cryptographic related :).

4. Ifyouinclude any Windows specific code (or a derivative thereof) from the apps directory (application code)

you must include an acknowledgement: “This product includes software written by Tim Hudson
(tjh@cryptsoft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
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WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

* The licence and distribution terms for any publically available version or derivative of this code cannot be
changed. i.e. this code cannot simply be copied and put under another distribution licence [including the GNU
Public Licence.]

/

License (zlib)

/* zlib.h -- interface of the “zlib” general purpose compression library version 1.2.3, July 18th, 2005

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided “as-is”, without any express or implied warranty. In no event will the authors be held
liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and
to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original
software. If you use this software in a product, an acknowledgment in the product documentation would be
appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the
original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly jloup@gzip.org

Mark Adler madler@alumni.caltech.edu
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